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Dear customer,

thank you for having decided for a BYK-Gardner product. BYK-Gardner is committed to providing
you with quality products and services. We offer complete system solutions to solve your
problems in areas of color, appearance and physical properties. As the basis of our worldwide
business, we strongly believe in total customer satisfaction.

Therefore, in addition to our products, we offer many VALUE-ADDED services:

· Technical Sales Force

· Technical and Application Support

· Application and Technical Seminars

· Repair and Certification Service

BYK-Gardner is part of ALTANA AG and a direct subsidiary of BYK, a leading supplier of additives
for coatings and plastics. Together, we offer complete and unique solutions for you, our
customer.

Thank your for your trust and confidence. If there is anything we can do better to serve your
needs, do not hesitate to let us know.

Your BYK-Gardner Team

· https://www.byk-instruments.com 

https://www.byk-instruments.com


byko-visc RT BYK-Gardner GmbH

8 300 003 478 - 2301

For Your Safety1.1

CAUTION: Familiarization with safety instructions necessary

Failure to read and understand the safety instructions threatens your health and can
damage the instrument. Read the safety instructions before you use the instrument the
first time.

The safety instructions are part of the delivery content. You find the safety instructions
in the dedicated booklet enclosed to the instrument carrying case.

The safety instructions also include information about disposal, liability and copyright.

WARNING: Injuries possible

This manual cannot address all of the safety considerations associated with its use. It is
the responsibility of the user to consult this manual and establish appropriate safety
practices for use with this equipment and the individual material being tested.

The byko-visc viscometers are designed and intended for the use described in the
manual. Using the viscometer for other purposes for which it was not designed may
reduce or eliminate the protection offered by the features of the device. Serious injury
may result.

This instrument is not intended for use in a potentially hazardous environment or with
materials that may release toxic or flammable gases at the temperatures encountered
during testing.

Never defeat the ground conductor or operate the equipment in the absence of a
suitably installed ground conductor. Contact the appropriate electrical inspection
authority or an electrician if you are uncertain that suitable grounding is available.

WARNING: Severe material damage

Only devices meeting the requirements for low voltage safety may be connected to the
USB interface.
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Symbols1.2
The label on the instrument contains the following symbols.

Do not dispose of this product together with your household trash. Please refer to
the information of your local community or contact our dealers regarding the
proper handling of end-of-live electric and electronic equipment. Recycling of this
product will help to conserve natural resources and prevent potential negative
consequences for the environment and hum health caused by inappropriate waste
handling.

Read the instruction manual before operation.

The manufacturer or importer affirms the good's conformity with European health,
safety, and environmental protection standards. Details see Declarations .

This symbol denotes the TUV certification mark for the United Kindom and the
European Union.

This symbol denotes the TUV certification mark for Canada and the United States.

11
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Disclaimer1.3

Exclusion of Liability

No liability other than as provided by law is assumed for direct or indirect damage sustained in
association with the use of the instrument, the software or documentation.

BYK-Gardner precludes all liability claims if the usage described in "Intended Use" is disregarded.
Any other usage than described in "Intended Use" is not according to the purpose of the
instrument and leads to termination of liability claims.

See also

· Intended Use

Copyright1.4
Specific properties and structural characteristics of the instrument are intellectual property of
BYK-Gardner. The copyright of this manual remains with BYK-Gardner.

This document must not be reproduced fully or in party, published or used for any other
competitive purposes, no matter whether against payment or not, without prior written
authorization from BYK-Gardner.

BYK-Gardner reserves the right to update the instrument, software and written documentation
without prior notice.

© Copyright 2023 BYK-Gardner GmbH

All rights reserved

13
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Declarations1.5

Declaration of Conformity (EU)1.5.1
We,

BYK-Gardner GmbH

Lausitzer Strasse 8

D-82538 Geretsried

declare, that the instrument byko visc RT complies with the requirements of the following EU
directives:

· 2014/30/EU - Electromagnetic Compatibility

· 2014/35/EU - Low Voltage

The following harmonized standards were applied:

· EN 61010-1:2010

· EN 61326-1:2013

Geretsried, November 2021

Frank R. Wagner
Managing Director

Declaration of Conformity (UK)1.5.2
Hereby,

BYK-Gardner GmbH

Lausitzer Strasse 8

D-82538 Geretsried

declares, that the products of type byko visc RT comply with the requirements of the following
directives for Electromagnetic Compatibility (EC) of the European Union (EU):

· S.I. 2016/1091 - Electromagnetic Compatibility Regulations

· S.I. 2016/1101 - Low Voltage

The following harmonized standards were applied:

· EN 61010-1:2010

· EN 61326-1:2013

Geretsried, November 2021

Frank R. Wagner
Managing Director
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The byko visc RT is a benchtop viscometer which is operated by the touch screen. The power
button - used to switch on the instrument - is located on the rear of the instrument above the
power connector. Using the touch screen display icons and functions can be selected directly. The
instrument can be used to repeatably measure viscosity of many types of liquid samples in the
laboratory and in production.

Intended Use2.1
Thank you for acquiring your new byko visc RT viscometer from BYK-Gardner.

 

The byko visc RT is a rotational viscometer, based on the measurement of the torque of a rotating
spindle in a sample at a specified velocity. Three different available spring torques, as well as
various accessories, allow it to cover a wide range of viscosity measurement.

 

The instrument is designed for indoor use. For supported functions see Feature Matrix .15
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Measurement Principle2.2
The instrument uses a precise stepper motor drive to rotate a specially designed spindle at a
specific RPM in a sample of liquid. A torque spring is connected between the spindle immersed in
the sample and a sensor system to determine the amount of torque required to rotate the spindle
through a sample. The torque requirement can then be used to calculate the viscosity of the
sample.

 

The touchscreen display allows user interaction with the instrument and the display of
measurement results. Results can also be saved and transferred to a USB thumb drive for
importation into Microsoft Excel on a PC for further data analysis.
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Feature Matrix2.3
The BYK-Gardner byko-visc RT product family offers a wide range of high quality benchtop
viscometers. For every purpose the best instrument is available. The  byko-visc RT product group
offers the premium models. The byko-visc RT Lite product group offers the economic models.

byko-visc RT byko-visc RT Lite

Low viscosity
Regular viscosity
High viscosity

8356: byko-visc RT L
8357: byko-visc RT R
8358: byko-visc RT H

8350: byko-visc RT Lite L
8351: byko-visc RT Lite R
8352: byko-visc RT Lite H

Measurement range Low: 1(*) - 6,000,000 cP
Regular: 5(*) - 40,000,000 cP
High: 300 - 320,000,000 cP

(*) With Low Viscosity Adapter (LVA)
accessory

Low: 1(*) - 2,000,000 cP
Regular: 5(*) - 13,000,000 cP
High: 300 - 106,000,000 cP

(*) With Low Viscosity Adapter (LVA)
accessory

Spindles included byko-visc RT L: 4
byko-visc RT R: 6
byko-visc RT H: 6

byko-visc RT Lite L: 4
byko-visc RT Lite R: 6
byko-visc RT Lite H: 6

Speed range 0.1 to 250 rpm 0.3 to 200 rpm in 21 steps

No. of speeds Freely selectable within speed range 21

Repeatability 0.2% 0.2%

Accuracy 1.0% of full-scale range 1.0% of full-scale range

Preset memory 6 memory locations for
measurement settings presets

 - 

Measurement mode Multi-point Single-point

Measurement
features

Curve Fitting, Multi-Step Ramp, QC
Limits, Time to Stop, Time to Torque

Time to Stop, Time to Torque

Data display features Current viscosity, torque,
temperature, graph and table over
time

Current viscosity, torque,
temperature

Temperature
measurement

PT100 temperature probe PT100 temperature probe (optional)

Product image

For more product details see https://www.byk-instruments.com/c/1535#1896.

https://www.byk-instruments.com/c/1535#1896
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The entire system consists of instrument, power supply and a set of spindles.

Delivery Content3.1
The items listed below are contained in the packaging:

· Rotational viscometer instrument mounted to adjustable stand

· 4 spindles for L spring models, 6 spindles for R and H spring models

· Temperature probe (standard on RT, optional accessory on RT Lite)

· Documentation: Safety Instructions and Short Instructions

· Certificate with instrument calibration data

· External power supply

· Spindle storage rack

· Spindle guard

Please contact BYK-Gardner if any item is missing or damaged.

NOTICE

Retain the packaging in case you want to ship the instrument at a later date.
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Control Elements3.2
Control of the instrument is provided by following elements.

1 Touch-screen display

2 Adjustable stand:

· Knob for vertical adjustment

· Lock for horizontal adjustment

3 Spindle attachment (protective cap
removed)

4 Support rod for stand

5 Spindle protector (form depends on
model)

6 Spindle

7 Base for stand

8 Sample container(*) 

9 Adjustable feet (3x)

(*) Not included, recommended: 600 ml low form glass beaker (see Ordering Information )

Viscometer Head3.3
On the back of the viscometer head following controls / connectors are provided.

1 External power supply

2 Power button: Power on and off

3 USB Type A:

· USB flash drive

· USB printer (or vice versa)

4 USB Type C: PC communication(*) 

5 Temperature probe

(*) Not used yet, foreseen for upcoming firmware versions

NOTICE

Before switching off the instrument always return to the Main Menu  to save all data.
In order to turn off the unit press the power button (2) and the unit will shut down.
After switch off always wait 30 seconds before you switch on again. To disconnect the
unit from the power source unplug the external power supply from (1).

59

20
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Instrument Set-up3.4
Perform following steps:

1. Place the viscometer in a suitable location.

2. Turn protective cap clockwise to access spindle attachment.

3. Plug the power supply into a mains outlet and plug the output cable into the back of
the viscometer head.

4. Turn instrument on with the power button located on the back of the viscometer head.

5. After power on a level check takes place; use the adjustable feet to level the instrument.

6. A message appears when instrument is leveled; after 3..5 seconds the zero screen is
displayed.

7. Press green Start button to start the zero check; the zero viscosity point is automatically
determined.

 

After finishing zero check the instrument will automatically go to the main menu.

CAUTION!

To avoid damage of the precise mechanic: Always remove the spindle and attach the
protective cap before moving the instrument.

NOTICE

Tap on the icon with the question mark to open the context sensitive help.

System Operation3.5
The instrument is operated using the icons on the touch-screen display to select functions and
configure settings.
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Main Menu3.5.1
In the main menu the following symbols are displayed.

Viscosity Measurement

Perform measurements using existing parameters, change parameters and save
results in instrument memory.

Browse Measurements

View and manage measurement results saved in instrument memory.

Measurement Settings

Change measurement settings and / or instrument configuration.
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Configuration Options3.5.2
To configure the system the following options are available.

 

Activated

The current option or function is active. Tap to deactivate.

Deactivated

The current option or function is inactive. Tap to activate.

Save

Save your changes and go back to previous screen.

Back

Go back to previous screen with existing settings.

Close

Go back to previous screen without saving.

NOTICE

If there is a check mark for Save it is to be tapped to save the changes in the current
screen. If there is no such check mark all changes are automatically saved.



4
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Tap the settings icon in the main menu to manage settings that are often changed. Before
starting with measurements these parameters may have to be controlled.

For settings that are seldom changed see System Configuration .

Spindle4.1
Here the spindle currently mounted can be selected to announce it to the measurement system.

The spindle to be selected depends on the viscometer model, namely the spring torque. Make
sure that spindle matches instrument. The spindle type is printed on the head of the spindle.

29



byko-visc RT BYK-Gardner GmbH

24 300 003 478 - 2301

Speed4.2
Enter the speed of the spindle in Revolutions per Minute (RPM).

Type in the requested value - between 0.1 and 250 - and save with the check mark.

Density4.3
Enter the target density value of the material to be measured.

This option is available, if activated under System Configuration  > Density .29 30
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Time to Stop4.4
Enter the measurement time here. Activate the option to go the the screen Time to Stop.

Use the arrow buttons to enter Hours, Minutes and Seconds and save with the check mark.

Time to Torque4.5
Enter the target torque here. Measurement will stop, when the given value has been reached.
Activate the option to go the the screen Time to Torque.

Enter the value (in percent) and save with the check mark.
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Ramp4.6
Enter a dynamic speed range here. Instrument will adjust speed accordingly. Activate the option
Ramp and tap the values to go the details screen Ramp.

Enter a Start Speed greater Zero (e.g. "5") and an End Speed (e.g. "50") and the required Steps
for increasing / decreasing the speed (e.g. "9"). The measurement time for the ramp-up is
calculated by the instrument.

Limits4.7
Here you can specify torque values to be observed for quality control. An alarm can be activated
if current sample is not within the give range.

Tap on Set Upper Limit to enter the maxmium torque values (e.g. "5%"). Repeat for Set Lower
Limit (e.g. "95%"). Finally select the Type for the alarm: Buzzer, Display Flash or Both.
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Curve Fitting4.8
Select the curve fitting model according to the rheological behavior of your sample; this curve
fitting should be applicated on the ramp curve you did before on your sample and it gives
rheological parameters you need to identify your products.

Following curves can be selected:

· None

· Newton

· Bingham

· Casson

· Ostwald

· Hershel-Buckley

Select the required curve from the list and save with the check mark. 



5
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Tap the settings icon in the main menu and tap on Configuration to manage settings that are
seldom changed.

Before starting with measurements the configuration may have to be controlled.

Units5.1
Select the units used for measurement.
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For the Viscosity following units are supported:

· Milli Pascal Second: mPa.s

· Centepoise: cP

For the temperature following units are supported:

· Celsius: °C

· Farad: °F

Select the required unit and save with the check mark.

NOTICE

The configuration for Units will be used as default and can also be changed directly
during measurements.

Density5.2
If this option is activated the Density  appears in the Measurement Settings .

If the option is active, the instrument switches to a special measurement mode, see Density .

24 23

43
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Language5.3
Select the language of the user interface here.

Following languages are supported:

· English: English

· German: Deutsch

· Spanish: Español

· French: Français

· Russian: Pycckuu

· Japanese:    

· Chinese:   

Select the required language and save with the check mark.
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Date / Time5.4
Here you can enter date, time and the format.

The Time is entered with Hour and Minute. The Date is entered with Day, Month and Year.
For Date and Time the Format to be displayed can be selected.

Color-Scheme5.5
If this option is activated the white background of the display turns to black. This option is
preferred in case of darker surroundings.

If this option is deactivated the background turns back to white.
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Information5.6
Under this option the details about instrument, firmware version and serial number can be
retrieved.

In case you contact your local BYK-Gardner service center please have these data handy.

Factory Reset5.7
This option can be used to reset instrument to the factory settings.

Tap on Factory Reset and follow the instructions on the display to perform the reset.
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Save Results5.8
This option can be used to turn on saving the results of the viscosity measurements, see Browse
Measurements .

If this option is deactivated the measurements results are not saved and will not be shown in the
browse screen.

Lock Settings5.9
This option can be used to lock the current settings against unintentional changes.

If this option is deactivated the settings can be changed again.

51
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Custom Spindle5.10
This option can be used to announce custom spindles to the viscosity measurement system.

For custom spindles the specific Spindle Coefficient and a Spindle Name to identify the
spindle is to be entered.



6
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Tap the measurement icon in the main menu to access the measurement screen. For viscosity
measurements perform following steps:

· Attach Spindle

· Measure Viscosity

· Change Parameters

· Access all Screens

· End Measurment

Attach Spindle6.1
Perform following steps:

1. If protective cap is attached, turn it clockwise to remove.

2. Move spindle attachment upwards, insert spindle and release attachment.

3. To remove the spindle do the same and release the spindle.

The spindle attachment can be kept with one hand.

The spindle can be attached with the other hand. On the spindle head the type label is available.

37

38

39

40

41
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The spindle attached has to be selected in Measurement Settings  > Spindle   - or directly in
Measure Viscosity .

Measure Viscosity6.2
To measure viscosity a sample container is necessary (not part of delivery). We recommend a 600
ml low form glass beaker.

Perform following steps:

1. Go to the main menu.

2. Tap the measurement icon.

3. The measurement screen is displayed.

4. Lower unit into sample and tap the green Start button.

5. The measurement is started using the existing settings.

Re-adjust vertical and horizontal position of the instrument head, if required - see Control
Elements .

23 23

38

18
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The measurement screen displays the following items.

 

1 TTS / TTT Counter for Time to Stop or Time to Torque

2 Viscosity Average of measurements - taken every spindle revolution, tap unit to
change

3 Maximum Maximum value, depending on current spindle and speed

4 Speed Current spindle speed in rotations per minute (RPM), tap value to change

5 Spindle Identifier for current spindle, tap entry to change

6 Torque Current value in percent: Values < 15% or > 95% indicate that speed or
spindle settings should be changed (invalid measurement)

7 Temp Current temperature of sample in °C or °F (if temperature probe is attached)

8 Graph Live updating graph of viscosity over time

9 Start Green Start button: Start and resume measurement

10 Pause Blue Pause button: Pause measurement

11 Stop Red Stop button: End measurement and save results

12 Help White Question mark: Open context-sensitive help

Change Parameters6.3
During measurement following parameters can be changed directly:

1. Units : Tap on the unit currently shown.

2. Speed : Tap the speed in RPM currently shown.

3. Spindle : Tap the spindle name currently shown.

29

24

23
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To change all other settings, stop the measurement and go back to the Measurement Settings .

Access all Screens6.4
Swipe left and right to access the other screens:

· Graph: Measurement data in graphical form

· Table: Measurement data in table form

 

You can also double swipe left and right to access the other screens.

23



BYK-Gardner GmbH byko-visc RT

300 003 478 - 2301 41

End Measurement6.5
To end the measurement first tap the blue Pause button and than on red Stop button.

To end the measurement directly tap the Back button in the title row.

A confirmation for saving the data is displayed.

Tap on the file name to change it, if required. For saving you have following options:

· No: Current measurement data is not saved, use this to make quick measurements
without saving.

· Yes: Current measurement data is saved in instrument memory.

NOTICE

The dialog box Save? will be displayed, if option Save  is active in System
Configuration .

Go to Browse Measurements  to check the results or make a new measurement.

34

29

51
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The instrument supports various viscosity measurement modes:

· Density

· Time to Stop

· Time to Torque

· Ramp-Up

· QC-Limits

· Curve Fitting

· Temperature

Density7.1
To use the Density feature perform following steps:

1. Go to System Configuration  and activate the option Density.

2. Go to Measurement Settings  and tap on the option Density.

3. Enter the target density value of the material to be measured.

4. Perform a measurement and check the results.

 

The density is measured in Centistokes (cSt).

43

44

45

47

46

48

49

29

23
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Time to Stop7.2
To use the Time to Stop feature perform following steps:

1. Go to Measurement Settings  and tap on Time to Stop.

2. Enter the time duration the measurement should last.

3. Perform a measurement and check the remaining time.

 

The measurement is stopped when the time has expired. Press Play to restart measurement.

NOTICE

The time feature can be used alternatively to Time to Torque .

23

45
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Time to Torque7.3
To use the Time to Torque feature perform following steps:

1. Go to Measurement Settings  and tap on Time to Torque.

2. Enter the target torque at which the measurement should stop.

3. Perform a measurement and check the current torque value.

 

The measurement is stopped when the given torque has been reached. Press Play to restart
measurement.

NOTICE

The torque feature can be used alternatively to Time to Stop .

23

44
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QC-Limits7.4
To use the QC Limits feature perform following steps:

1. Go to Measurement Settings  and tap on Limits.

2. Enter the required values for Upper and Lower limit.

3. Select the required Alarm type: Buzzer or Flash or Both.

4. Perform a measurement and check the current torque value.

 

In the given example the display will start to flash if the torque measured is below 20% or above
60% of target value.

NOTICE

The limits feature can be combined with Ramp  and with Time to Stop  or with
Time to Torque .

23

47 44

45
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Ramp-Up7.5
To use the Ramp-up feature perform following steps:

1. Go to Measurement Settings  and tap on Ramp.

2. Enter the required values for the ramp:

· Start speed: 0.1 ... 150 RPM 

· End speed: 0.1 ... 150 RPM 

· Steps: 2 ... 500 

3. Perform a measurement and check ramp data and current speed in RPM.

 

In the given example the instrument will start at 5 RPM, increase to 20 RPM and will end when 50
RPM have been reached. The measurement time for the ramp-up is calculated by the instrument.
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Curve Fitting7.6
To use the Curve Fitting feature perform following steps:

1. Go to Measurement Settings  and tap on Curve Fitting.

2. Select the required curve and save with the check mark.

3. Activating Curve Fitting simultaneously activates Ramp-Up .

4. Tap on Ramp and configure the ramp-up to be measured.

5. Go to Measure Viscosity  to start the ramp measurement.

 

During measurement swipe left or right to access data and table screen. When the ramp has
finished, tap on Back or Stop. The curve fitting results are listed:

· Behavior Index (BI)

· Consistency Index (CI)

· Correlation Factor (R2)

· Plastic Viscosity (PV)

· Yield Value (YV)

This depends on the curve selected:

· Newton: R2, PV

· Bingham: R2, PV, YV

· Casson: R2, PV, YV

· Ostwald: R2, CI, BI

· Hershel-Buckley: R2, CI, BI, YV

With Export to USB  / Print to USB  following data will be exported:

· Name of measurement file

· Curve fitting data

· Ramp data
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Temperature7.7
The temperature probe PT100 is part of the delivery.

To measure the temperature of your sample perform following steps:

1. Attach the temperature probe to the Viscometer Head .

2. Fix the cable for the probe on the spindle protector.

3. Insert spindle and temperature probe into the sample.

4. Perform a measurement and observe the temperature.

 

Tap on the temperature value to change the Units , if required.
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Using this function you can manage the measured data. Click on icon Browse. The final viscosity
value for a measurement is displayed here.

Following operations are supported:

· Rename Test Series

· Export to USB

· Print to USB

· Delete Data

NOTICE

You can select single or multiple test series. Alternatively you can select all test series at
once.

Rename Test Series8.1
You can rename existing test series. Perform following steps:

1. Tap the check box for the series to be renamed.

2. Tap on button File Name.

3. Enter the new file name.

4. Tap on OK to save name.
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NOTICE

The default file name can be configured in Date / Time .

Export to USB8.2

Export to USB to see all viscosity values measured over time. Perform following steps:

1. Attach USB flash drive to the viscometer head.

2. Select all test series to be exported.

3. Tap on the Export USB icon.

4. Wait until process finishes.

5. Connect USB drive to PC.

6. Use MS Excel to view data.
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NOTICE

The export format is Comma Separated Values (CSV). In MS Excel create an empty sheet
and select Data > Get Data > From File > From Text/CSV to convert the data in your
file.

Print to USB8.3

You can directly print a test series to a USB printer. Perform following steps:

1. Attach USB printer to the viscometer head.

2. Select all test series to be printed.

3. Tap on the Print USB icon.

4. Wait until process finishes.

We suggest a USB label printer, for example the Dymo Labelwriter 450 or 550.

Depending on paper role you can print labels for the probes or just paper output.
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Delete Data8.4

Measurement data not required anymore can be deleted from instrument memory. Tap the test
series to be deleted - to delete all test series at once tap on button Select All - and tap on button
Delete.

Tap on Yes to confirm the request. The selected objects are deleted. To abort the deletion tap on
No.
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Firmware Update9.1
To update the firmware of your instrument perform following steps:

1. Go to System Configuration  and tap on Information.

2. Check the current firmware version.

3. Get the new firmware, it is a compressed file of type "byko_update_x.y.z.tar.gz".

4. Copy the file into root directory of a USB flash drive.

5. Go to the Main Menu .

6. Attach the flash drive to the Viscometer Head .

7. The new firmware is detected and automatically installed.

8. Do not switch off the instrument during the update!

9. The system performs a reboot to load the new firmware.

10. Check the new version in the information screen.

In case you contact your local BYK-Gardner service center please have these data handy.

NOTICE

The file with the new firmware will automatically be deleted from the USB flash drive.
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Technical Data9.2
All technical data are subject to change without notice.

Instrument9.2.1

Catalog number 8356: byko-visc RT L (Low viscosity)
8357: byko-visc RT R (Regular viscosity)
8358: byko-visc RT H (High viscosity)

Measurement range byko-visc RT L: 1* - 6,000,000 cP
byko-visc RT R: 5* - 40,000,000 cP
byko-visc RT H: 300 - 320,000,000 cP
* With Low Viscosity Adapter (LVA) accessory

Spindles included byko-visc RT L: 4
byko-visc RT R: 6
byko-visc RT H: 6

Speed range 0.1 - 250 rpm

No. of speeds Freely selectable within speed range

Repeatability 0.2%

Accuracy 1.0% of range

Preset memory 6 memory locations for measurement settings presets

Measurement features Curve Fitting, Density, QC Limits, Multi-point Tests

Programmable features Time to Stop, Time to Torque, Multi-step Ramp

Temperature measurement PT100 temperature probe

Display Capacitive color display

Languages English, German, French, Italian, Spanish, Russian, Japanese,
Chinese
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General Data9.2.2

General Data

Usage Indoor use

Temperature range 10° C to 40° C (50° F to 104° F) for operation
0° C to 60° C (32° F to 140° F) for storage

Relative humidity Up to 85% non-condensing at 35° C (95° F)

Operation altitude Up to 2000 m (6561 ft)

Dimensions (LxWxH) 250 x 310 x 470 mm (9.8 x 12.2 x 18.5 in)

Interface 2x USB Type A
1x USB Type C

Weight 6.5 kg (14.3 lbs)

Power supply 24 V  , max. 1.25 A

Fuse Bourns SF-1206SA250W-2 rated at 2.5 A

External power supply Input: 100 - 240 V  ; 50 - 60 Hz ; max. 0.7 A
Output: 24 V  ; max. 1.25 A
Vendor: Mean Well
Model: GE30I24
Safety standards: UL62368-1, CSA C22.2 NO. 62368-1,TUV BS
EN/EN62368-1, AS/NZS 60950.1, CCC GB4943,EAC TP TC 004 approved

Overvoltage category I

Pollution degree 2

Documentation9.2.3

Safety Instructions 300 003 475 26 languages

Short Instructions 300 003 476 8 languages

Operating Manual 300 003 478 E English

Download: https://www.byk-instruments.com/p/8356 

https://www.byk-instruments.com/p/8356
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Maintenance9.3

Cleaning and Routine Maintenance

Remove the spindle after use to clean. Severe damage to the instrument can occur if the spindle is
cleaned while mounted to the viscometer. The stainless steel paddle spindle may be cleaned with
solvents required for the material being measured and a non-abrasive cloth. 

Remove spilled material from the instrument case and base. Avoid solvents on the faceplate and
the color display as they may be seriously damaged by strong solvents.

Restart instrument to check both leveling and zero check in regular intervals.

Troubleshooting

If problems occur, verify that power is being applied, first to the power supply then from the
power supply to the instrument. If the power is good, disconnect the power supply from the back
of the instrument for at least 30 seconds, reconnect the power supply and turn on the power
switch. If problems persist, please contact your local BYK-Gardner office.

Service and Spare Parts

For all service and spare parts requirements, please contact your local BYK-Gardner office.

Do not perform any repairs on the unit. The unit must be opened by BYK-Gardner authorized
repair locations only. Repair as this will void the warranty and affect the safety protection.

Ordering Information

byko-visc RT L byko-visc RT R byko-visc RT H

Viscometer with stand (8356) Viscometer with stand (8357) Viscometer with stand (8358)

Spindle set L (4981) Spindle set R / H (4986)

Spindle guard L (300003462) Spindle guard R / H (300003430)

Spindle rack (300003438)

Temperature probe (8363)

Glass beaker, 600ml, low form (8364)

Power supply (8360)
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Service Points9.4

List of global service centers with ISO / IEC 17025 accredited laboratories

Headquarter Germany

c/o BYK-Gardner GmbH

Lausitzer Strasse 8 82538
Geretsried / Germany

Headquarter USA

c/o BYK-Gardner USA

9104 Guilford Road Columbia,
MD 21046 / USA

Headquarter PTE

c/o BYK USA dba
Paul N. Gardner

316 N.E. First Street, Pompano
Beach, FL 33060 - 6608 / USA

BYK-Gardner Service Point
Austria, Hungary, Slovenia

c/o Friedrich W. Bloch GmbH

Wagramerstrasse 201 1210
Vienna / Austria

BYK-Gardner Service Point
France

c/o Eckart France S.A.S.

31 Rue Amilcar Cipriani 93400
Saint Ouen / France

BYK-Gardner Service Point
Spain

c/o Actega Artística S.A.U.

Calle Balmes 8, Suite: 3º2ª
08291 Ripollet / Spain

BYK-Gardner Service Point
China

c/o BYK (Tongling) Co. Ltd.
Shanghai Branch

Block 6A, Building A, No 88
Hong Cao Road, Xuhui District,
Shanghai 200233 / P.R. China

BYK-Gardner Service Point
India

c/o IMCD India 
Private Limited

1101-03, B-Wing, ONE BKC,
Bandra Kurla Complex, Bandra
East, Mumbai, MH. Pin.:400
051. India

BYK-Gardner Service Point
Japan

c/o Tetsutani Co. Ltd.

Chuo-ku, Osaka Tokuicho 2-2-2 /
Japan

BYK-Gardner Service Point South Latin America

c/o MAST Comercial e Importadora LTDA

Rua Itaporanga, 340-B, Bairro Paraiso, Santo André - SP, 09190-640 / Brazil

Complete list: https://www.byk-instruments.com/global-service-centers 

List of authorized agents: https://www.byk-instruments.com/contact-infos 

https://www.byk-instruments.com/global-service-centers
https://www.byk-instruments.com/contact-infos


BYK-Gardner GmbH byko-visc RT

300 003 478 - 2301 61

Notes
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Notes



BYK-Gardner GmbH
Lausitzer Strasse 8
82538 Geretsried
Germany

Tel +49 8171 3493-0
Fax +49 8171 3493-140

info.byk.gardner@altana.com
www.byk-instruments.com

https://www.byk-instruments.com/p/8356

Download your manuals from:
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https://www.byk-instruments.com/contact-infos
https://www.byk-instruments.com/contact-infos
https://www.byk-instruments.com/contact-infos
https://www.byk-instruments.com/contact-infos
https://www.byk-instruments.com/contact-infos
https://www.byk-instruments.com/contact-infos
mailto:info.byk.gardner@altana.com
https://www.byk-instruments.com/p/8356
https://www.byk-instruments.com/en/micro-tri-effect
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